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IEEE Corporate PowerPoint  
Quick Start Guide

Windows and Mac
Create new presentations or refresh old ones using the 
IEEE Corporate PowerPoint template and this Guide. 

Step-by-step instructions and frequently asked questions 
take you though the new templates to elevate your 
presentations to the next level.

Need assistance creating a new or editing an  
IEEE PowerPoint or Google Slides presentation?   

IEEE Frequently Asked Questions
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The new IEEE Quick Start Corporate 
PowerPoint template includes updated 
features and an easy-to-use guide.
The instructions are designed to work with the latest versions of  
Office 2016/2019, Office 365, and Online. To ensure you have the 
best experience, please check your software version of PowerPoint.

What’s new:
• Fresh, bold design with a variety of content slides
• Contemporary look and feel with options for divider slides
• Compelling imagery that you can keep, or edit and replace
• Improved usability and flexibility when working with templates
• Better accommodation of content and visual elements
• Adaptable to any audience and subject matter
• Recommended best practices for presentations
• Intuitive PowerPoint training videos and resouces
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Note, your PowerPoint desktop software may look different than the online 
PowerPoint (One Drive) version. Some of the screens represented in this user 
guide are for reference and may look different than what you are experiencing. 

If you need additional assistance, please visit Microsoft PowerPoint support.
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Basics Guide  Pages 3-8
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IEEE Master Brand PowerPoint Templates
•  Link to IEEE Brand Experience website for helpful

guidelines and PowerPoint templates you can download.

Tips and How-to Video on Converting Existing 
Presentations and Customizing New Templates
•  Link to a list of frequently asked questions related to the

IEEE Brand Identity Toolkit. Educate yourself and your
team before you begin.

•  Watch the video. Learn how to merge presentations and
replace or add photographs and logos.

IEEE Corporate PowerPoint Alternate 
Color Series
•  Download PowerPoint templates. Each deck contains a full

set of slides in one color theme with coordinating imagery.

•  Select IEEE Brand Blue or one of the 16 accent colors from
the approved IEEE Brand Color Palette.

Google Slides
•  Watch the Google Slides tutorial before you begin. We

have provided answers to frequently asked questions in
this helpful video.

New Templates to Download and How-to Videos 
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What is an IEEE Slide Master?
When you want all slides to contain the same fonts and 
images (such as logos), you can make the changes in the 
Slide Master, and the change will be applied to all slides. 

1. Navigate to View Tab.

2. Select Slide Master Button.

The slide master is the first slide in the thumbnail panel in the 
Slide Master view. 

1. Slide Master.
2. Layout Masters, inherits all changes from slide master 

When you edit the Slide Master (1), all slides linked to the 
master will contain those changes. However, the majority of 
changes you make will most likely be to the Layout Masters (2).

Note, if you are working in Normal View and find that you 
are unable to edit an element on a slide (such as, “why am I 
unable to remove this picture?”) it may be because the element 
you are trying to change is defined on the Slide Master or 
Layout Master. 

Presentation Basics and Tips

Where is the Slide Master?
If you are used to creating your presentations in Slide 
Master View in the PowerPoint desktop application, you 
have probably noticed that PowerPoint online version 
(One Drive) for the web does not have a slide master.

If your using PowerPoint for the web, click Open  
in PowerPoint.
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What are IEEE Themes?
A theme is a palette of branded colors and fonts that 
complement each other. The pre-designed IEEE theme is 
available on the Design Tab in Normal view. 

All IEEE themes include a slide master and a related set of 
layouts. It is recommended that you do not have more than 
one theme in your presentation. 

You can download additional themes from the IEEE Brand 
Experience website.

What are IEEE Templates?
A template is a theme, plus some content for a specific 
purpose such as a sales presentation, business plan, or a 
classroom lesson.

Templates have design elements that work together (colors, 
fonts, backgrounds, effects) and generic content that you can 
change to tell your IEEE story.

You can create and save your own custom templates and 
share with others. 

Download IEEE PowerPoint templates in the Corporate Blue or 
one of 16 accent additional colors from the approved branded 
color palette.

Presentation Basics and Tips



7 brand-experience.ieee.org

What is an IEEE Slide Layout?
Change and manage slide layouts in Slide Master view. Each 
theme has several slide layouts. Choose a layout that best 
matches your slide content. 

Note, some layouts are designed for text while other layouts 
work better with photos or graphics.

Presentation Basics and Tips

Why it is Best to Start Fresh When Applying 
an IEEE Template?
Even if you have existing slides, we recommend you apply 
a template to it by starting fresh with the template and then 
importing the existing slides into the new template. 

This process helps ensure that everything in your IEEE 
presentation (especially things you have not created yet) 
adopts the look and branding of the prescribed template.
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Best Practices for Creating a Better 
PowerPoint Presentation
Clip art. Fancy fonts. Animations. Charts. Graphics. Sound. 
A wide variety of color schemes. PowerPoint provides a lot 
of options for creating a more exciting presentation. But do 
not be tempted to use them all or your message could  
get lost.

Here are a few helpful tips when creating a presentation.

Before You Start

• Think about your audience

• Decide what you want them to learn

• Avoid telling them what they already know

•  Organize your information so your presentation has a 
beginning, middle, and an end

•  Make sure slides will build on/follow each other to 
deliver message

Keep the Message Simple
• Limit one message per slide

• Write short, powerful headlines

• Decide what to show on each slide and what to speak

•  Use “seven by seven” rule: no more than seven lines of 
text on each slide. No more than seven words per line

• Use the notes section to add additional information

• Create a script

Best Practices

• Use visuals that conveying a global concept

• Combine visuals with text for added interest and impact

• Avoid visuals or “chart junk” that do not add to the message

Tips for Effective Presentations 
•  Keep design elements consistent and avoid using too  

many colors

•  Use Calibri as your typeface, it is a universal font that is 
compatible on any device

• Use upper and lower case — not all caps

• Use consistent messaging and images

•  Use photos, if from outside source there could be usage 
fees, as well as usage permission

• Review all content for proper branding

Get Ready to Present and Practice
•  Show the presentation to someone not involved in the 

project to see if they understand it

•   Think about how you can keep your audience involved; 
prepare challenging questions you can ask during your 
presentation to encourage participation



Windows 
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Windows - Quick Start Guide
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Create an IEEE Presentation
Download the IEEE Branded PowerPoint templates.

1. Open PowerPoint.

2. In the left panel, select Open.

3.  Select the IEEE Branded Presentation.

Add an IEEE Slide
1. Navigate to Home Tab.

2.  In thumbnails on left panel, select the Slide you want  
your new slide to follow.

3. Select New Slide.

•  From menu select the Layout you want to insert.

• A new slide will be added.

Windows - Quick Start Guide
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Add and Format Text on IEEE Text Slide
1. Navigate to Home Tab.

2. Insert Cursor into text box and type a few words.

3.  Select the Text.
•  Select a Font, Increase Font Size, Decrease  

Font Size, Bold, Italic, Underline, etc.

4.  Create bulleted and numbered lists, select the Text  
and select Bullets or Numbering.

Add Photos, Shapes, Tables, and Charts
1. Navigate to Insert Tab.

2. To add a picture:

• Select Pictures.

•  In the Picture Menu, select Source, and from menu 
photo browser, picture from file, stock image, etc. 

• Select the image and click Insert.
3. To add illustrations:

•  In the Illustrations section, select Shapes, Icons,  
3D Models, SmartArt, or Chart.

•  Select the illustration type and prompts to insert.

Windows - Quick Start Guide
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Merge Old PowerPoint Files into the New  
IEEE Master Brand Template

OPTION 1 - Reuse Slides Tool

This feature merges slides from one presentation into 
another, matching the theme of the new presentation.

Open the New IEEE Master Brand Template.

1. Navigate to Home Tab.

2. Select the New Slide button.

•  Click the Reuse Slides option at the bottom  
of the drop-down menu that appears.

3.  A menu will appear. Click Browse to locate the 
older PowerPoint file you want to import.

4.  Select the PowerPoint file, click Open to insert file.

Continued on next page

Windows - Quick Start Guide
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OPTION 1 - Reuse Slides Tool, continued
5.  A list of slides from your older presentation will appear 

in the Reuse Slides menu.

•  Do not check the Keep Source Formatting box. 
If the box is checked the old formatting will be 
imported into the new presentation. 

•  The objective is to not import the old formatting 
into the new presentation. 

6.  Right-click each slide you want to import and select 
Insert Slide. 

•  Or click Insert All Slides, this will copy all slides 
into the new presentation.

• Confirm the slides have been imported.

•  Save the file by clicking File > Save or Save As.

Windows - Quick Start Guide

NOTE: Importing slides from different PowerPoint 
files may have unexpected results and will only work 
on content with default placeholders. 

Content that does not import with the new 
formatting should be deleted and manually 
re-entered into the new template. This ensures 
all your slides will look the same.
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Copy and Paste Slides from Old Presentations 
into New IEEE Master Brand Template

OPTION 2 - Copy and Paste Tool
This is an alternate way to copy slides from one presentation 
and insert them into another.

1.  Navigate to Home Tab, in the thumbnail bar on the left 
click on the Slides you want to copy. 

2.  Right-click on the Slides and select Copy.

3.  Open the new PowerPoint file and right-click  
At The Location you want the slides inserted.

• Two paste options are available:

•  Click Use Destination Theme so the slides inherit 
the new formatting (Preferred).

•  Or click Keep Source Formatting to keep old 
format (Not Preferred).

•  Confirm the slides have been pasted into the 
presentation.

• Save the file by clicking File > Save or Save As.

Windows - Quick Start Guide
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Saving the IEEE Master Brand 
Template as a Theme
1.  Navigate to Design Tab and click 

the Bottom Arrow to expand the 
theme carousel window.

2. Click Save Current Theme at the 
bottom of window.

3.  Name the theme “IEEE Master 
Brand Template”.

4.  Click Save and the presentation 
will be saved in the theme bar.

Windows - Quick Start Guide
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Apply the IEEE Master Brand 
Theme to Existing Presentation
1.  Navigate to Design Tab and right-click  

on the IEEE Master Brand Template 
and click Apply to All Slides.

2.  You may need to re-apply the layout 
function to change old bullets and text 
styles and update with the new format.

• Navigate to Home Tab.

• Click On Slide.

•  Click on Layout Button in menu bar 
and select the style from the drop-
down menu to apply.

 NOTE: This will only work on content with 
default placeholders. You may need to 
reformat other content manually and delete 
unnecessary elements.

Windows - Quick Start Guide
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Difference Between a Title Slide, 
Divider Slide, and Content Slide
•  Title slides are used as a cover slide.  

New presentations automatically populate 
with the “Presentation Title” slide.

•  Divider slides are used to break up content 
sections. There are two options for the 
divider slides.

•  Content slides are a variety of preloaded 
slides in the layout section for you to choose 
(copy only, copy with images, multiple 
images, etc).

Copy and Paste Text into an IEEE 
Slide Template
1.  Copy text from source document.

2.  Navigate to Home Tab, right-click on the 
Copy Block where you want to add text.

3.  Click on Paste Button in menu bar, click 
Use Destination Theme to apply new 
formatting.

•  You may need to adjust and reformat 
some text and bullets.

Windows - Quick Start Guide
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Change Images on Cover Page
 IEEE presentations have a default cover page. 
If you prefer to change the images use the 
directions below.

1.  Navigate to Home Tab and click on 
Layout Button in menu bar and select the 
“Title Slide” from drop-down menu.

2.  Change image by clicking Icon within each 
image block.

• File window opens.

•  Browse and select a New Image.

• Click Insert.
3.  Adjust the cropping.

•  Click the Image. 

•  Click the Picture Tools & Format Tab, 
click on Crop. Move image to desired 
position.

Windows - Quick Start Guide
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Placing Images and Photos 
 Not all slides have editable fields. 

1. To select an editable slide, navigate to 
Home Tab and click on Layout Button 
in menu bar and select a slide with an 
Image Block Icon.

•  Only slides with image block 
icons are editable.

Insert Images and Photos onto 
a Slide
1.  Click on a Image Block Icon,  

and a File Window opens.

2.  Browse and select an Image.

• Click on Insert.
3.  Adjust the cropping.

•  Click the Image. 

•  Click the Picture Tools & Format 
tab, click on Crop. Move image to 
desired position.

•  Hold Shift while resizing image to 
retain aspect ratio.

Windows - Quick Start Guide
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Copying Design Elements and  
IEEE Wedge on Master Pages
1.  Navigate to View Tab, then click on  

Slide Master.
2.  A list of all Master Slides are on left.

•  Select a Master Slide that contains 
design elements you are looking for.

3.  Click on the Design Element. 
•  Hold Shift Key to select multiple 

elements.

• Right-click and select Copy.

4. Click Close Master View.

5.  Select the Slide you want to paste the 
design elements into.

• Right-click and select Paste.

Windows - Quick Start Guide
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Mac - Quick Start Guide
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Create an IEEE Presentation
Download the IEEE Branded PowerPoint templates.

1. Open PowerPoint.

2. In the left panel, select Open.

3.  Select the IEEE Branded Presentation.

Add a Slide
1. Navigate to Home Tab.

2.  In thumbnails on left panel, select the Slide you want  
your new slide to follow.

3. Select New Slide.

•  From menu select the Layout  
you want to insert.

• A new slide will be added.

Mac - Quick Start Guide
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Add and Format Text
1. Navigate to Home Tab.

2. Insert Cursor into text box and type a few words.

3.  Select the Text.
•  Select a Font, Increase Font Size, Decrease 

Font Size, Bold, Italic, Underline, etc.

•  Create bulleted and numbered lists, select the Text 
and select Bullets or Numbering.

Add Photos, Shapes, Tables, and Charts
1. Navigate to Insert Tab.

2. To add a picture:

• Select Pictures.

•  In the Picture Menu, select Picture From File, and  
locate the photo on your computer. 

• Select the photo and click Insert.
3. To add illustrations:

•  In the Illustrations section, select Shapes, Icons,  
3D Models, SmartArt, or Chart.

•  Follow the steps displayed.

Mac - Quick Start Guide
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Merge Old PowerPoint Files into the New  
IEEE Master Brand Template

OPTION 1 - Reuse Slides Tool

This feature merges slides from one presentation into 
another, matching the theme of the new presentation.

Open the New IEEE Master Brand Template.

1. Navigate to Home Tab.

2. Select the New Slide button.

•  Click the Reuse Slides option at the bottom  
of the drop-down menu.

3.  Navigate to the old presentation and Click OK to 
import the slides.

Mac - Quick Start Guide

NOTE: Importing slides from different PowerPoint 
files may have unexpected results and will only work 
on content with default placeholders. 

Content that does not import with the new 
formatting should be deleted and manually 
re-entered into the new template. This ensures 
all your slides will look the same.
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Copy and Paste Slides from Old Presentations 
into New IEEE Master Brand Template

OPTION 2 - Copy and Paste Tool

This is an alternate way to copy slides from one presentation 
and insert them into another.

1.  Navigate to Home Tab, in the thumbnail bar on the left 
click on the Slides you want to copy. 

2.  Right-click on the Slides and select Copy.

3.  Open the new PowerPoint file and right-click  
At The Location you want the slides inserted.

• Two paste options are available:

•  Click Use Destination Theme so the slides inherit 
the new formatting (Preferred).

•  Or click Keep Source Formatting to keep old 
format (Not Preferred).

•  Confirm the slides have been pasted into the 
presentation.

• Save the file by clicking File > Save or Save As.

Mac - Quick Start Guide
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Saving the IEEE Master Brand 
Template as a Theme
1.  Navigate to Design Tab and click 

the Bottom Arrow to expand the 
theme carousel window.

2. Click Save Current Theme at the 
bottom of window.

3.  Name the theme IEEE Master 
Brand Template.

4.  Click Save and the presentation 
will be saved in the theme bar.

Mac - Quick Start Guide
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Apply the IEEE Master Brand 
Theme to Existing Presentation
1.  Navigate to Design Tab and right-click  

on the IEEE Master Brand template 
and click Apply to All Slides.

2.  You may need to re-apply the layout 
function to change old bullets and text 
styles and update with the new format.

• Navigate to Home Tab.

• Click On Slide.

•  Click on Layout Button in menu bar 
and select the style from the drop-
down menu to apply.

Mac - Quick Start Guide

NOTE: Importing slides from different PowerPoint files may have unexpected results 
and will only work on content with default placeholders. 

Content that does not import with the new formatting should be deleted 
and manually re-entered into the new template. This ensures all your 
slides will look the same.
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Difference Between a Title Slide, 
Divider Slide, and Content Slide
•  Title slides are used as a cover slide. New 

presentations automatically populate with 
the “Presentation Title” slide.

•  Divider slides are used to break up content 
sections. There are two options for the 
divider slides.

•  Content slides are a variety of preloaded 
slides in the Layout section for you to 
choose (copy only, copy with images, 
multiple images, etc).

Copy and Paste Text into an  
IEEE Slide Template
1.  Copy text from source document.

2.  Navigate to Home Tab, click on the 
Copy Block where you want to add text.

3.  Click Paste in menu bar, click Use Destination 
Styles to past copy and apply new formatting.

•  You may need to adjust and reformat some 
text and bullets.

Mac - Quick Start Guide
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Change Images on Cover Page
 IEEE presentations have a default cover page. 
If you prefer to change the images use the 
directions below.

1.  Navigate to Home Tab and click on 
Layout Button in menu bar and select 
the Presentation Title Slide Opt 1 - 
Editable from drop-down menu.

2.  Change image by clicking Icon within  
each image block.

• File window opens.

•  Browse and select New Image.

• Click Insert. 
 
Continued on next page.

Mac - Quick Start Guide
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3.  Adjust the cropping.

•  Click the Image. 

•  Click the Picture Format Tab, 
click on Crop. 

•  Hold Shift and scale image to 
desired size.

Mac - Quick Start Guide
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Placing Images and Photos 
 Not all slides have editable fields. 

1. To select an editable slide, navigate 
to Home Tab and click on Layout 
Button in menu bar and select a slide 
with an Image Block Icon like Photo 
with Caption.

•  Only slides with image block icons 
are editable.

Insert Images and Photos 
onto a Slide
1.  Click on a Image Block Icon,  

and a File Window opens.

2.  Browse and select an Image.

• Click on Insert.
3. Adjust the cropping.

•  Click the Image. 

•  Click the Picture Format Tab, 
click on Crop. 

•  Hold Shift and scale image to 
desired size.

Mac - Quick Start Guide
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Copying Design Elements and 
IEEE Wedge on Master Pages
1.  Navigate to View Tab, then click  

on Slide Master.
2.  A list of all Master Slides are on left.

•  Select a Master Slide that contains 
design elements you are looking for.

3.  Click on the Design Element. 
•  Hold Shift Key to select multiple 

elements.

• Right-click and select Copy.

4. Click Close Master View.

5.  Select the Slide you want to paste the 
design elements into.

• Right-click and select Paste.

Mac - Quick Start Guide
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Additional Resources
The guidelines are extremely important to IEEE and its entities, 
adding more value, consistency, and organization to the IEEE Brand.

Thank you for supporting the IEEE Brand Experience. 
Together, we make the brand stronger.

IEEE Brand Identity Tools

IEEE Brand Identity Toolkit 
brand-experience.ieee.org/toolkits/

IEEE Master Brand and Logos 
brand-experience.ieee.org/guidelines/master-brand-and-logos/

IEEE Brand Identity Guidelines 
(PDF, 15 MB) 
brand-experience.ieee.org/guidelines/brand-identity/ 

Questions?

Please contact the IEEE  
Experience Design Team 
exd-team@ieee.org


